1 | Short cut key for jump to last
Edited slide

a) Alt+shift+F5
b) Alt+shift+F3
c) Alt+shift+F2
d) Alt+shift+F1
Answer-a

2. What is the shortcut key of
LibreOffice help ?
a) F12
b) F7
c) F11
d) F1
Answer-d
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3. First RuPee ATM &Micro ATM
Card with Aadhaar Number was
issued by ?
a) Union Bank of India
b) ICICI Bank
c) Bank of India
d) Axis Bank
Answer-c

Scanne! d with CamScanner



'L.-'l AT WA 1T IRArdd
3 ]d) Axis Bank
swer-c

4. A Firewall can be
a) Hardware
b) None of the option
c) Software
d) Both(Hardware) and (Software)
Answer-d

5. What will to the result of
=Quotient(509.8,7)

Copyright Disclaimer under Section 107 of the copyright act 1976.
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a) 70
b) 77
g) 72
d) 75
Answer-c

6. What is the shortcut key for
Repeat
a) Alt+Shift+R
b) Shift+R
c) Ctrl+Shift+Y
d) Ctrl+Alt+Y
Answer-c
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<, Phonepe an example of
4 }) RTGS

b) IMPS
c) Pos

Copyright Disclaimer under Section 107 of the copyright act 1976.
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d) Ewallet

Answer-d

8. How many languages are
supported in Libreoffice 4.0.3.
a) 70
b) 40
c) 80
d) 75
Answer-b

9. Firewall is a type of
a) Prevention against unauthorized
access
b) Virus
c) Worm
d) Security threat
Answer-a



10. How many dally settlement

Yatches are there in NEFT during a
o Jeek day?

a) 11

b) 24

c) 23

d) 12
Answer-a

11. Commanly used database for
libreOffice writer form control is
a) Access
b) SQL
c) Base
d) My SQL
Answer-b
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12. What is the default width of Calc
columns

a) 2.26 CM
b) 2.5 inch
c) 2.5CM
d) 2.25inch
Answer-a

13. Which obtion is used to restrict
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13. Which option is used to restrict
scrolling of row and column
a) Stop
b) Freeze
c) Scroll off
d) Pause
Answer-b

14. Which of these is A chart type in
Calc

Copyright Disclaimer under Section 107 of the copyright act 1976.
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a) Circle
b) Hollow
c) Bubble
d) Baloon
Answer-c

15. Bootstrapping is also known as
a) Fast boot
b) Quick boot
c) Hot boot

d) Cold boot
Answer-d

16. What is the default font used in
libre office writer ?
a) Times new roman
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16. What is the default font used in

3

libre office writer ?
a) Times new roman
b) Liberation impact
c) Liberation serif

Copyright Disclaimer under Section 107 of the copyright act 1976.
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d) Ariel

Answer-a

17. Mobile application /App that

enables booking and cancellation of
unreserved tickets among a host of
other facilities

a) UTS

b) CRIS

c) SAARTHI

d) IRCTC

Answer-d

18. Which of the following feature is

currently not present in AEPS?
a) Virtual card creation

b) Balance enquiry

c) Cash withdrawal
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19. Conventional rules for correct
behaviour on the internet are known

- I ??
Rules

b) Protocols

c) Good behaviour

d) Netiquettes
Answer-d

20. What is defined by the handout
master
a) Layout formatting
b) Handout content formatting for
the word export
c) Slide formatting

Copyright Disclaimer under Section 107 of the copyright act 1976.
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d) Layout of audience handout notes

Answer-d

21. What does S stands for in PSP with
respect to UPI?
a) Service
b) Software
c) System
d) Synchronized
Answer-a
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22. What is the shortcut key for new
style in libre office writer

) Ctrl +F
11 p) Ctrl+F11
c) Shift+F7
d) Ctrl +F5
Answer-b

Copyright Disclaimer under Section 107 of the copyright act 1976.
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23. How many digits code are there in
mobile money Identifier (MMID)?
a) Eight digit code
b) Seven digit code
c) Nine digit code
d) Six digit code
Answer-b

24. E.mail are arranged in inbox with
respect to
a) Date time
b) Subject
c) Client&server
d) Names
Answer-a
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25. How many banks in India have
joined the international
telecommunication network swift’s

) 28
12 1)) 249
c) 19
d) 46
Answer-d

26. In a network with 25 computers
,which topology would require the
most extensive cabling
a) Star
b) Mesh
c) Ring
d) Bus

Answer-b

Copyright Disclaimer under Section 107 of the copyright acl 1976.
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27. Who is the “father” of artificial
intelligence ?
a) John McCarthy
b) Allen Newell
c) Charles Babbage
d) Fisher Ada
Answer-a

28. One of the items is not related
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28. One of the items is not related
with net-banking
a) RTGS
b) ECS
) NEFT
14 ) Demand draft
Answer-b

29. On an Libre Calc spreadsheet the
Active cell Indicated by

Copyright Disclaimer under Section 107 of the copyright acl 1976
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a) A blinking Border
b) A dotted border
c) A dark wide border
d) By italic text
Answer-c

30. “ To promote digital transactions,
an upgraded UPI for banks is being
proposed , what is UPI?

a) None of the mentioned

b) United payments Interface

c) Unified payments Interface

d) Unitary payments Interface
Answer-c

31. “How many worksheets are
available by default in a Libre
spreadsheet?
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a) 3
b) 1
c) 4
d) 2

swer-b
15 . From where can we set the timing

for each object

a) Format ,animation

b) Slide show, slide transition

c) View, animation

d) Slide show, custom transition
Answer-b

33. The user can close the libre
spreadsheet by pressing the
a) Ctrl +shift +E
b) Ctrl+H

Copyright Disclaimer under Section 107 of the copyright act 1976,
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c) Ctrl+Q
d) Ctrl+T
Answer-c

34. Which of the following is used for
international Monetary transfer?
a) None of the options
b) SWIFT
c) NEFT
d) RIGS
Answer-b
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35. Which of the following is not an
example of web browser ?
a) Google chrome.
b) Internet explorer.

c) Safari.
17 ) Avast.

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-d

36. Which of the following is not an
example of anti virus ?
a) Avast
b) Bit Defender
c) VLC
d) AVG
Answer-c

37. Sniffing is used for
fingerprinting.

a) Passive attack
b) Scanned
c) Passive banner grabbing

d) Active attack
Answer-a
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38. You are writing a message on

18 witter_ what is the maximum
umber of characters you can use

a) 160
b) 140
c) 120
d) 135
Answer-b

39. Which one is not an example of
video sharing website?
a) Metacafe
b) You tube
c) Pinterest
d) Dailymotion
Answer-c

40. Retweet is semantically

Copyright Disclaimer under Section 107 of the copyright act 1676
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a) None of the options
b) A fresh tweet
c) An arilyr tweet
d) Tweet on a tweet
Answer-d
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41. Who have world’s largest hadoop
cluster?
a) Data matics
b) Google
c) Facebook
d) Apple

20 wer-c
;2. Which social networking media

allows you to tweet your opinions?

a) Instagram
b) Linkedin

Copyright Disclaimer under Section 107 of the copyright act 1976.
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c) Twitter
d) Messenger
Answer-c

43. “The symbol ‘@” is know as
a) a
b) at
c) and
d) aspect
Answer-b

44. A live video can be streamed on
a) Facebook
b) Twitter
c) UMANG
d) CRIS
Answer-a
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Answer-a

45. “malware” is abbreviated as

Copyright Disclaimer under Section 107 of the copyright act 1976.
Taking copy or selling/sharing be Infringing under aclion.

INSTITUTE OF
21 COVIPUTER EDUCATION
a) Ad ware
b) Multicastsoftware
c) Malicious software
d) Malicious diagnostiware

Answer-c
46. MQTTIS coveeerererrerreneene protocol.
a) Machine to machine and internet of
things

b) Machine things

c) Machine to machine

d) Internet of things
Answer-a

47. Full form of RTGS is
a) Real time Gain Settlement
b) Real time Gross Settlement
c) Real time Gross Settement

Copyright Disclaimer under Section 107 of the copyright act 1976.
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d) Random time Gross settlement
Answer-b
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48. The UMANG app is developed by?
a) Ministry of I.T
b) Ministry of Defence
c) Ministry of finance
d) melTY and NeGD
Answer-d

. Default template in impress
22 resentation is
a

) Image only
b) Content only
c) Title and content
d) Title only
Answer-c

Copyright Disclaimer under Section 107 of the copyright act 1976,
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50. What is the short cut key for
superscript
a) Ctrl+shift+P
b) Ctrl+shift+D
c) Shift+P
d) Ctrl+P
Answer-a

51. Which search engine used in china
a) Google
b) Baidu
c) Bing
d) Yahoo
Answer-b
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52. Arobot’s “arm” is also known as its:
a) actuator
b) end effector

Copyright Disclaimer under Section 107 of the copyright act 1976.
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c) manipulator

d) servo mechanism
Answer-c

53. Shortcut key to move to next sheet in
Libreoffice Calc.
a) Page down
b) Ctrl + page down
c) None of the option
d) Shift + page down
Answer-b

54. QR code was developed by which
corporation
a) Fujitsu
b) Sony
c) Denso wave
d) Microsoft

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-c
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55. Shortcut to open function wizard
a) Ctrl+F9
b) Ctrl+F5
c) Ctrl+F8
d) Ctrl+F2
Answer-d

56. Application Software
) Used to make design only
) Performs specific task for computer
users
c) Designed to help programmers
d) Used to control the operating system
Answer-b

57. IVR can be accessed trough ?
a) Book

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) Images
c) Text
d) Phones
Answer-d

58. What is the Artificial intelligence ?
a) Making a machine intelligent
b) Programming with your own
intelligence
c) Playing a Game

d) Putting your intelligence into computer

Answer-a
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59. Who is the father of artificial
intelligence ?
a) Allen Newell
b) Fisher Ada
c) Alan Turing

Copyright Disclaimer under Section 107 of the copyright act 1976
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d) Von-Neuman
Answer-c

60. A device that converts a digital signal
to an analog signal is
a) P2M
b) PWM
c) DAC
d) ADC
Answer-d

61. Which of these is not an example of
social networking
a) LinkedIn
b) Twitter
c) WeChat
d) Amazon
Answer-d
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62. PNR status is available to the user
through ?
a) CRIS
b) IRCTC
c) RAIL SAARTHI
d) UMANG

2=swer-b

28 _
. What will be the result of

=round(17576,-5)
a) 9
b) 7
c) O
d) 6
Answer-c

Copyright Disclaimer under Seclion 107 of the copyright act 1976.
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64. The First Phase of hacking an IT

system is compromise of which
foundation of security ?
a) Integrity
b) Authentication
c) Availability
d) Confidentiality

Answer-d

Scanne! d with CamScanner



65. Which of these is not available in
paste special
a) Formulas
b) Graph
c) Values
d) Numbers
Answer-b

66. USSD was launched by

30 ht Disclaimer under Section 107 of the copyright act 1976.
king copy or selling/sharing be infringing under action.
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a) Bank of Baroda
b) Union Bank of India
c) SBI
d) RBI
Answer-d

67. Which one of the following is
word processing software
a) Libre Base
b) Libre Calc
c) Libre math
d) LibreOffice writer
Answer-d

68. Which digital payment company
announced a new feature QR code on
its app?
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68. Which digital payment company
announced a new feature QR code on
its app?

a) PayPal

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) Paytm

c) Payoneer

d) PayU
Answer-b

69. Receiving money from the UPI
system is called
a) Null
b) Pull
c) Full
d) Received
Answer-b

70. Udemy,Coursera,edX are example
of
a) Web portal
b) E-commerce
c) E-learning



d) Social networking
Answer-c

71. The mails that are not sent due to
communication issues, are stored
temporarily in:

a) Sent
b) Inbox
) Outbox
32 H) None of the options
Answer-c

72. The term cryptography is
a) Theft of software
b) Fraud
c) Artificial intelligence
d) Secret writer
Answer-a

Copyright Disclaimer under Section 107 of the copyright act 1976.
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73. USSD works on
a) GSM
b) TDM
c) Radio frequency
d) Microwave
Answer-a
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74. What does 3D means?
a) 3D display
b) Movies
c) 3 Dimensions
d) Computer graphics
Answer-c

75. Surfing clearly means to:
a) Watching online videos
b) Moving among websites

c) Downloading a file
34
opyright Disclaimer under Section 107 of the copyright act 1976.
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d) Uploading a file
Answer-b

76. What is the file extentntion of
Libre spreadsheet document ?
a) .0ODS
b) .ODT
c) .OBT
d) .ODF
Answer-d

77. How long a video can be recorded
on Instagram ?

a) None of the options
b) 5 to 10 seconds only
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77. How long a video can be recorded
on Instagram ?
a) None of the options
b) 5 to 10 seconds only
c) 3 to 60 seconds only
d) 10 to 30 seconds only
Answer-c

Copyright Disclaimer under Section 107 of the copyright act 1976.
Taking copy or selling/sharing be infringing under action.

INSTITUTE OF

COVMIPUTER EDUCATION
78. What is the advantage of LAN?
a) Back up of data
b) Access the web
c) Share peripherals
d) Save data
Answer-c

79. What is the use of filter in calc
a) Copy data
b) Making chart
c) See only specific data
d) Arrange data
Answer-c

80. The latest Google chrome is
capable of printing webpage in which
format?

a) Rtf
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b) Doc

c) Pdf

d) Docx
Answer-c

81. What is the shortcut key of Ruler
in libre office writer
a) Alt +shift +R
b) Ctrl + shift+R
c) Shift+R
d) Alt+R
36 swer-b

82. MAC address is of ......ccecvvveennn. Size.
a) 32 bit
b) 128 bit
c) 48 bit
d) 64 bit

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-c

83. What term describes a
background that appears as a grainy,
non smooth surface
a) Pattern
b) Velvet
c) Gradient
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d) Texture
Answer-c

84. What is the maximum zoom in of
libra writer
a) 500
b) 600
c) 700
d) 550
Answer-b

Copyright Disclaimer under Section 107 of the copyright act 1976.
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85. Which of the following is not a
transition effect
a) Blinks diagonal
b) Blinds vertical
c) Fade through black
d) Dissolve
Answer-a

86. An electronic check is one form of
what?
a) e-check
b) check
c) online banking
d) e- commerce
Answer-c
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87. Sending money on UPI is called
a) Push

Copyright Disclaimer under Section 107 of the copyright act 1976.
Taking copy or selling/sharing be infringing under action.

@ INSTITUTE OF
COVIPUTER EDUCATION
b) Sent
c) Drop
d) Pop

39 swer-d

88. In the logo of twitter, there is a:
a) Deer
b) Bird
c) Fox
d) Cat
Answer-b

89. Maximum number of columnsin a
Libre spreadsheet is
a) AMJ
b) ASP
c) AIM
d) MMA
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90. “New Innovation” is
a) Forensic
b) The use of artificial intelligence
c) Drawback of Al
d) Thept of Al
Answer-b

91. Pos needed for payment
a) Biometric
b) Card and pin
c) Password
d) CVV and Expiry Date
Answer-d

40 f The very new web browser given
n windows 10 is:

a) Edge

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) Safari
c) Internet Explorer
d) Opera
Answer-a

93. What s the Potential danger in

downloading free anti-spyware?

a) It has limited use

b) None of the option

c) it might actually contain spyware
that tracks your online activity

d) it might not really be for free

Answer-c
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94. What is the transaction limit per
day using BHIM?
a) 50000
b) 20000

Copyright Disclaimer under Section 107 of the copyright act 1976
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c) 30000
d) 40000

Asgwer-d
42 1 ,
. The work done on the Internet is

called

a) Surfing

b) Gambing

c) Hosting

d) Typing
Answer-a

96. In which year RTGS start in India?
a) 2006
b) 2005
c) 2003
d) 2004
Answer-d



97. Extension of LibreOffice writer file
is
a) .toc
b) .odt
c) .ods
d) None of the options
Answer-b

98. Extension of LibreOffice Calc file is
a) .odt
b) .odp
c) .odp
d) .ods
Answer-d

43 ]E Extension of LibreOffice Impress
ile is

a) .ods

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) .odp
c) .odx
d) None of the options
Answer-b

100. Which option is used in google
chrome for private browsing?
a) Secure Window
b) Spy window
c) Private Window
d) Incongnito Window
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Answer-d

101. What is the short cut key for making
libre office writer in full screen mode
a) Ctrl+shift+)
b) Ctrl+shift+F3
c) Ctrl+shift+D

Copyright Disclaimer under Section 107 of the copyright act 1976.
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d) Ctrl+shift+F
Answer-b

45 })2. What is the minimum age to create a

facebook account?
a) 13
b) 15
c) 14
d) 12
Answer-a

103. What is the transaction charges for

the RTGS amounting between 2 lakh to
5 lakhs?

a) 25
b) 30
c) 50
d) 100

Scanne! d with CamScanner



Anéwer—b

104. In which menu toolbar and Zoom lies
a) File menu
b) Data menu
¢) Tool menu
d) View menu
Answer-d

105. Which one is not a function in
spreadsheet
a) AVG()
b) MIN()
c) MAX()
d) SUM()

wer-a
46 e : :
6. Which is a feature included in

libreOffice Impress software that allows
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the user to see all the slides in a single
window
a) Reading view
b) Slide sorter
c) Slide Master
d) Handout Master

Answer-b

107. UTS stand for ?
a) Unreserved Ticketing schedule
b) Unreserved Ticketing system
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a) Reading view

b) Slide sorter

c) Slide Master

d) Handout Master
Answer-b

107. UTS stand for ?
a) Unreserved Ticketing schedule
b) Unreserved Ticketing system
c) Unreserved Tracking system
d) Unresrved Transfer System
Answer-b

108. What is the Short Cut key For
Creating Table in LibreOffice?
a) Ctrl+F12

47 pyright Disclaimer under Section 107 of the copyright acl 1976.
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b) Shift+F12
c) Ctrl+F9
d) Shift+F9
Answer-d

109. An electronic page in a libreOffice
Impress is called
a) e-slide
b) Slide
c) Page
d) e-Page
Answer-b
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110. .png stands for
a) Portable Network graphics
b) Portable new Graphics
c) Part network graphics
d) Peripheral network graphics

Copyright Disclaimer under Section 107 of the copyright acl 1976
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Answer-a

111............... can be used to track a
mobile phone.
a) IMEl number

49 ) Mobile Modal Number
c) None of the options

d) Mobile number
Answer-a

112. What is the maximum zoom size in
Libre Spreadsheet
a) 200%
b) 400%
c) 500%
d) 300%
Answer-b



113. Which of the following should be
used when you want to add a slide to
an existing presentation
a) File, new
b) Insert, new slide
c) File, add a new slide
d) File, open

Answer-b

114.To go to next slide press
a) PageDown
b) Down Arrow Key
c) Shift+ arrow key
d) End
Answer-a

15. Who is Founder of E-mail ?
50 ) Ray Tomlinson

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) Bill Gates
c) Steve Jobs
d) None of the optins
Answer-a

116. How much money transfer through
upi

a) 10000

b) 20000

c) 50,000

d) 100000
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Answer-d

117. PMSBY stands for
a) Pradhan Mantri secure Bima Yojna
b) Pradhan Mantri security Bima Yojna
c) Pradhan Mantri Suraksha Bima Yojna
d) None

Copyright Disclaimer under Section 107 of the copyright acl 1976
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Answer-c

118. NUUP stands For
a) National Unified USSD Platform
b) National Unifier USSD Platform

52 ) National Universal USSD Platform

d) None of the options
Answer-a

119. IMPS stands for
a) Immediate fund transfer service
b) Immediate Payment Service
c) Interested Payment Service
d) Both A&B
Answer-b

120. Where to get the Deleted Emails
a) Sent mail
b) Outbox
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c) Inbox
d) Trash mail
Answer-d

121. Which one is the best Encyclopedia
a) Google
b) Wikipedia
c) Quora
d) Yahoo
Answer-b

122. Who Owner of Instagram
a) Google
b) Facebook
c) Microsoft
d) Twitter
Answer-b

53 yright Disclaimer under Sectlion 107 of the copyright act 1976.
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123. What is another name for
Proprietary Software
a) Closed Source software
b) Open Source Software
c) Paid Software
d) Freeware
Answer-a

124. Short cut key for Heading 3 ?
a) Shift+3
b) Ctrl+3
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124, Short cut key for Heading 3 ?
a) Shift+3
b) Ctrl+3
c) Shift+1
d) Ctrl+1
Answer-b

125. Who is the first Graphics web
Browser ?
a) Mosaic

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) World Wide Web
c) Netscape

) Safari
wer-a

55

126. What is TT in HTTP ?
a) Text Transfer
b) Test Transformed
c) Test Transfer
d) None of the optins
Answer-a

127. What does B stands for in BFD with
rest to AEPS?
a) Biometric
b) Best
c) Binary
d) Balance
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Answer-b

128. In AEPS, Unique ID and is used
for authentication purpose
a) Password
b) PIN
c) Biometric
d) None of the optins
Answer-c

129. What is the Full Form of SEQ?
a) Senior Engineer Office
b) Search Engineering Outcomes
c) Search Engine Optimization

d) System Environment Option
Answer-c

130. We cannot send E-mail without
filling subject line

pyright Disclaimer under Section 107 of the copyright act 1976.
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a) TRUE
b) FALSE
Answer-b

131. Which is not spreadsheet view
a) Normal
b) Page Layout
c) Page Break Preview
d) Web Layout

Ancwar_d
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132.|VR stands for?
a) Inter Voice Response
b) Interactive Voice Response
c) Interactive Voice Request
d) Interactive Value Respond

Answer-b
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133. Which option is used to show the
color bar within cell according to data
a) Conditional Formatting
b) Data Bar
c) Bar Chart
d) Text Formatting

f=swer-a
o8 l
4. Which of the following is a safety

measure in banking network?
a) Router
b) Protocol
c) Firewall
d) Modem
Answer-c

135. Immediate Payment Service
(IMPS) facility is provided by?
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a) RBI
b) NPCI
c) AEPS
d) BBPS
Answer-b

136. Mailbox is made up of ?
a) Head&Body
b) Body&Subject
c) Inbox&OQOutbox
d) CC&BCC
Answer-b

137.In HTTPs ‘s’ stands for
a) Simple
b) Secured
c) System
d) Server

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-b

138. Change the................ TO create a
document in wide format
a) Page Orientation
b) Page margins
c) Paper Source
d) Paper Style
Answer-a
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138. Change the................ To create a
document in wide format
a) Page Orientation
b) Page margins
c) Paper Source
d) Paper Style
Answer-a

139. Which of the following will not
advance the slides in a slide show
view ?

a) Esc key

b) Enter key

c) None of the options

d) Mouse button
Answer-a
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140. What is shortcut key combination

to decrease font size in LibreOffice
writer?

a) Ctrl+-

b) Ctri+|

c) Ctrl+<

d) Ctrl+(

Answer-b

141. In LibreOffice Calc, “Comment”
option can be found
under.........menu.

a) Insert
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141. In LibreOffice Calc, “Comment”
option can be found
under......... menu.
a) Insert
b) View
c) Format
d) Data
Answer-a
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142. Ruler in LibreOffice Writer can

help us in
a) Tab settings
b) Indents settings

) All of the options

) Change page margins

Answer-c

143. While typing in a paragraph, you

will

a) Press Enter key at the end of each
word

b) Press Enter key at the end of each
line

c) None of the options

d) Press Enter only at the end of a
paragraph

Answer-d
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144. The entire URL has a maximum of
a) 127 characters
b) 255 characters
c) 63 characters
d) 31 characters
Answer-b

145. Networking such as LAN, MAN
started from:
a) Third genration
b) Fourth genration
c) First generation
d) Second generation
Answer-b

146. To mention Someone in a
WhatsApp group we use the symbol:
a) #
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b) $
c) None of the options
d @

Answer-d

147. What is a trigger, in context of
animations
a) An action button that advances to
the next slide
b) Anitem on the slide that perform
an action when clicked
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148. Wizards submenu is available
under which menu

Copyright Disclaimer under Section 107 of the copyright act 1976.
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a) View
b) Edit
c) File
d) Insert
Answer-c

149. Shortcut key for full screen
browsing in google chrome
a) F11
b) F5
c) Shift+F
d) F12

er-a
65
. What is shortcut key combination

to decrease font size in LibreOffice
Writer?
a) Ctrl+<
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150. What is shortcut key combination

to decrease font size in LibreOffice
Writer?
a) Ctrl+<
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b) Ctrl+-
c) Ctrl+(
d) Ctrl+|
Answer-d

151. Which of the following options in
the printer dialog box would you
select to print slides5and 12 in a
presentation?

a) Slides
h) Custom shows

66 J’ Current slide
All

Answer-a

152. What will be the result of
=round(175,-2)
a) 200
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Answer-a

153. In libre writer by default
highlighter color
a) Yellow
b) Blue
c) Green
d) Red
Answer-a

154. What is the maximum value of
save AutoRecovery option (in mins) in
libre writer
a) 60
b) 20
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67 |c) 100
d) 50

Answer-a

155. Which command is used to make
slide effective
a) Clip Art
b) Graphics
c) Transition
d) Insert
Answer-c
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156. To create a message or mail we
click on.............7
a) CC
b) Compose
c) BCC
d) Create

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-b

157. The topology in which all devices
connected to each other in a closed
loop:

a) Bus
b) Mesh
c) Ring
d) Star

- lwer-c
158. UIDAI Stand for?

a) Unique Identification Authority of
India

b) Unique Identification
Authentication of India

c) Usefull Identification Authority of
India
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1d) Unique Identity Authority of India

Answer-a

159. Which key is used in combination
with another key to perform a
specific task
a) Spacebar
b) Control
c) Arrow
d) Function

Answer-b

160. One cell format can be copied to
another cell by using ?
a) Format checking
b) Cloning
c) Format Setting
d) Clone Formating

Copyright Disclaimer under Section 107 of the copyright act 1976.
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wer-d

161. What is an item of storage
medium in the form of circular plate
a) CPU
b) ALU
c) Disk
d) Printer

Answer-c
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162. What is the meaning of ###### in
a cell data
a) Refrencing error
b) Divide By Zero
¢) Formula Error
d) Cell width is not enough
Answer-d

Copyright Disclaimer under Section 107 of the copyright act 1978
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163. What is the use of Bookmark in
web browser?
a) For saving web pages on PC
b) For saving Cookies
c) For storing Books
d) For storing the path of favorite
website
Answer-d

4. In hyperlink dialog box which

72 ption is not available

a) Internet

b) File Attachment
c) Mail

d) Document
Answer-a
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165. In LibreOffice Calc, “Comment”
option can be found under.............
Menu.

a) View

b) Data

c) Format

d) Insert
Answer-d

166. Which of the following is the
default page setup orientation of
slide in LibreOffice Impress
a) Vertical
b) Portrait
¢) Landscape
d) Horizontal

Answer-c
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67. The Extension given to a paint file
73 Is
a) .txt

b) .doc

c) .xlIx

d) .bmp
Answer-d

168. The spelling dialog box can be
involved by choosing spelling from
weeeee MeENU
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168. The spelling dialog box can be
involved by choosing spelling from
wreees MENU
a) Insert
b) File
c) Tools
d) View

Answer-c
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169. Which of the following options

changes the fill color of an object
back to the default color
a) Fill color
b) Template
c) Patterns
d) Automatic

Answer-d

0. Which of the following is the
75 .
orrect order of the four major
functions of a computer
a) Process, Storage, Input, Output
b) Process, Output, Input, Storage
c) Input, Process, Output, Storage

d) Input, Output, Process, Storage
Answer-c
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171. In LibreOffice Calc, which option
can be used to split window?
a) Tools-> Split Window
b) View-> Split Window
c) Window-> Split
d) Foemat-> Split Window
Answer-c

172.1BM 1401 computer was
a) None of the options
b) Mainframe computer
c) Mini computer
d) Micro computer
Answer-b

173. Platform where a writer shares
his views on individual subject?
a) LinkedIn
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b) Twitter

) Blogs
76 E) Facebook
swer-b

174. Framework to link various hospital
based on adhaar
a) Online Registration System
b) Operated Registered System
c) Online Register System
d) Online Registration Synchronized
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Answer-a

175. What is the shortcut key for page
Break

a) Ctrl+shift
b) Alt+Ctrl+Enter
c) Ctrl+Enter

Copyright Disclaimer under Section 107 of the copyright act 1976.
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d) Alt+Enter
Answer-c

176. The actual message of the E-mail
is contained in the ?
a) Receiver
b) Body
c) Subject
d) Sender
Answer-b

177.What is the most important
activity in system hacking?

a) Information Gathering
) Escalating privileges

c) Cracking passwords

d) Covering Tracks
Answer-c
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178. Who maintains the RTGS payment
network?
a) IRDA
b) SEBI
c) RBI
d) NPCI
Answer-c

179. What is size of IPV6 address
a) 32 bit
b) 8 bit
c) 64 bit
d) 128 bit
Answer-d

180. To move to the beginning of a line
of text, which key will be pressed
a) Home

Copyright Disclaimer under Section 107 of the copyright act 1976.
Taking copy or selling/sharing be infringing under aclion.

® INSTITUTE OF
CONMPUTER EDUCATION
b) Page up
c) Shift

d) Enter
79 }wer—a
181. A digital certificate
a) is an electronic message uniquely
identifying the message sender,
b) is a reliable third party that
authenticates the message sender

c) is used to identify the owner of a
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c) is used to identify the owner of a
private key and related public key
d) is a summary of a plain text
document
Answer-a

182. Shortcut key to insert date in
LibreOffice Calc.
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a) CTRL+;
b) CTRL+1
c) CTRL+,
d) CTRL+2
Answer-a

183. What option will be select for
surfing smartphone’s internet to
computer ?

a) Mass Storage

b) USB tethering

c) MTP

d) FTP

81 jwer-b

184. Extension of LibreOffice Calc
Template file:
a) *.ots
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184. Extension of LibreOffice Calc
Template file:
a) *.ots

Copyright Disclaimer under Section 107 of the copyright act 1976.
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b) *.xltm
c) *.ods
d) *.xltx
Answer-a

185. Single platform for the Indian
citizens to access PAN india services
a) CRIS
b) IRCTC
c) UTS
d) UMANG
Answer-d

186. The number of columns in a Calc
spreadsheet ...........
a) None of the options
b) 4
c) 255

82 yright Disclaimer under Seclion 107 of the copyright acl 1976.
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d) 1024
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187. If the displayed system time and
date is wrong, you can reset it using
a) Write
b) Calendar
c) System Settings
d) Write file
Answer-c

188. Which of the following can you
use to add times to the slides in a
LibreOffice Impress
a) Slide transition button
b) Animation Button
c) Slice Show menu
d) Rehearse timing button

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-d

189. Which enables us to send the
same letter to different persons?
a) Macro
b) Mail merge
c) None of the options

) Both Macro and Mail Merge
wer-b

190. To go to previous slide press
a) Pageup
b) Home
c) Up Arrow Key
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190. To go to previous slide press
a) Pageup
b) Home
c) Up Arrow Key
d) Shift+ arrow key
Answer-a

191. In LibreOffice Calc, shortcut key

used for Paste Special
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a) Ctrl+V
b) Ctrl+alt+shift+V
c) Shift+V
d) Ctrl+shift+V
Answer-d

192. It is a mediated environment
which creates the sensation in a user
of being present in a (physical)
surrounding

a) GUI

b) WWW

c) Virtual Reality

d) HMD

85 ]wer-c

193. Maximum attachment size in
Gmail is
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a) 30 MB
b) 20 MB
c) 15MB
d) 25 MB
Answer-d

194. Maximum size of text available in
drop down menu of font Size in
LibreOffice writer is
a) 64
b) 96
c) 84
d) 72

Answer-b

195. What is the short cut key for
subscript
a) Ctrl+Shift+K
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b) Ctrl+Shift+B
c) Shift+P
d) Ctrl+p
Answer-b

36 FG.To go to any specified slide press
a) Ctrl+spacebar

b) Shift+Slide Number
c) Slide number+ Enter
d) N+Enter

Answer-c
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197. What will be the result of
=floor(129,19)

a) 114

b) 113

c) 111

d) 112

Copyright Disclaimer under Section 107 of the copyright act 1976.
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Answer-a

198. Which programs are automatically
loaded and operates as a part of
browser.

a) Plug-ins
b) Widgets
c) Add-ons
d) Utilities
Answer-a

199. Which type of printer is used in
POS machines usually
a) Dot Matrix
b) Laser Printer
c) Ink Jet Printer
d) Thermal Printer

'—“Twer-d
88
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200. How to select one hyperlink after
another during a slide
a) Ctrl+D
b) Tab
c) Ctrl+K
d) Ctrl+H
Answer-b

201. How many photos can be
uploaded on Facebook at a time
a) 35
b) 30
c) None of the options
d) 25
Answer-b

202. Divide by zero error is
a) Div/0
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b) ~divError
c) #DIVO!
d) IDIV!
Answer-c

203. Cut, Copy and Paste isin ..............
roup in the Home tab.
89 ) Font Group
b) Page Setup
c) Font
d) Clipboard
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204. Which command will you choose
to convert a column of data into row?
a) Paste Transpose
b) Paste Special
c) Cut and Paste

Copyright Disclaimer under Seclion 107 of the copyright act 1976.
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d) None of the options
Answer-a

205. What is the shortcut key of Save
As option
a) CTRL+SHIFT+N
b) SHIFT+S
c) CTRL+SHIFT+S
d) CTRL+S
Answer-c

206. The maximum zoom percentage in
Libre Impress is
a) 200%
b) 100%
c) 500%
d) 400%
Answer-c
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207. UPI was launched by Whom?
a) R. Gandhi
b) SS Mundra
c) Raghuram Rajan
d) Urjit patel
Answer-c

208. FTP is responsible for
a) Upload/Download
b) Instant messaging
c) None of the option
d) Email
Answer-a

209. The number of rows in a Calc
spreadsheet...............
a) 36500
b) 256
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c) 1048576
d) 64536
Answer-c

210. Gmail will automatically delete
any trashed message after..........
Days.

) 90
) 45
c) 60
d) 30

92
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211. By default insert table button in
standard tools shows
a) 2 Rows 2 Columns
b) 5 Rows 5 Columns
c) 4 Rows 4 Columns
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d) 3 Rows 3 Columns
Answer-a

212. Which of the following commands
can be used to copy files across
systems?

a) ftp

b) ssh

c) telnet

d) rsh
Answer-c

213. What is shortcut key to open
format cell option dialogue box
a) Ctrl+D
b) Ctrl+L
c) Ctrl+F
d) Ctrl+1
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214. Mininum use of physical
documents and enabling e-
documents is done through?
a) DigiLocker
b) UMANG
c) MY PAN
d) EPFO

Answer-a

215. What is the shortcut key
combination to open goto box?
a) Ctrl+Shift+F7
b) Ctrl+Shift+F5
c) Ctrl+Shift+F6
d) Ctrl+Shift+F8
Answer-b
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216. What is the minimum length of
wifi password
a) 6
b) 4
c) 8
d) 5
Answer-b

217.what is the maximum number of
digits that a UPI-PIN can have?

o5 P)>
E)s

c) 4
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d) 6
Answer-d

218. Which of the following below is a
loop back address
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a) 127.0.0.0
b) 127.0.1.0
c) 127.0.1.1
d) 127.0.0.1
Answer-d

219. What does cloud means in cloud
computing
a) Internet
b) People
c) Hard drive
d) Wireless

Answer-c

220. Which feature starts a new line
whenever a word or sentence
reached a border
a) Text Wrapping
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